
Basic skills in the creation of a photomontage  
This tutorial was developed with Photoshop 4 but the info 
remains  useful for more recent versions. 

 

The Black Art of Photo-Editing 

While publishing on the desktop has become so mainstream that it is 
often difficult to remember the days of cut and paste, photo-editing 
has so far managed to maintain its mystery as a black art only to be 
practised by experts. For a while there were good reasons for this, 
but recent developments in software and processing power have 
changed the situation completely. In the professional repro house 
they are almost certainly using similar equipment and programs to 
those found in the office. Now there is no reason why the desktop 
user cannot at least explore the potential of professional photo-
editing. 

Of course many users will say that they already do use photo-editing 
software - that's how they scan in the graphics for the in-house 
newsletter or for their home page. In fact though they are almost 
certainly just scanning and saving, a hit-and-run approach that only 
scratches the surface of what can be achieved. This article is 
designed to show users both how to make the most of the photo-
editing they already do and also to expand their horizons to see what 
they could be doing. 

I'm going to take a typical real world example, the production of a 
photo montage, in this case of a proposed art gallery exhibition. 

  



Broadly speaking the project is going to be divided into two stages. 
First the individual images will be prepared. This involves acquiring 
the graphics, either by scanning or from disk, and then making sure 
they are of the optimum quality by colour correcting and if necessary 
retouching. Then, when the individual images are ready, we will see 
how they can be creatively combined and controlled to produce the 
desired end result. 

Compared to the computerised, artificial feel of drawn vector images 
the continuous tone end-results of photo-editing seem very natural, 
but the process that has created them is actually the most 
mathematical. That is why photo-editing benefits from as much RAM 
and processing power as can be thrown at it. To really get to grips 
with photo-editing it is important to remember - at least in the back of 
your mind - that to create the illusion of doodling with a paintbrush, 
behind the scenes the program is actually manipulating hundreds 
and often thousands of grid references and values. 

Set Up 

This knowledge immediately makes sense of the crucial concept of 
the "image modes" set when you create, or scan in, a new image. 
The image mode refers to the amount of information stored in each 
pixel. For a pure bitmap or black and white image, each pixel on the 
grid is either on or off (1 bit), for a grayscale image each pixel is one 
of 256 levels between pure white and pure black (8 bit), while for a 
full 16.7 million colour RGB image each pixel stores three values 
representing 256 levels of each of the primary colours Red, Green 
and Blue (24-bit). Your software and scanner might offer other 
intermediate options such as a cut-down 256 colour mode, but as this 
will offer no scope for future processing, stick to the main three. 

As the number of potential colours of the image modes increases, so 
does the corresponding file size and necessary processing time. The 
skill is to keep both of these to a minimum while ensuring the 
optimum quality. To do this you should know at what size your image 
will be finally output and, for grayscale and full colour images, the 
screen frequency measured in lines per inch (lpi) of your outputting 
device. Typically these range from around 60lpi for a laser printer to 
around 150lpi for high quality phototypeset output. There is no point 
in having too much extra information that will not appear in the final 



output so, for example, if your photo is to be output roughly size-for-
size on a 133lpi phototypesetter it would make sense to scan in at 
200dpi (dots per inch) which would still leave some room for 
flexibility.  

Also common nowadays is the use of stock photos from disk. For 
professional use these are likely to be supplied in PhotoCD format, 
and you can also have your own photos processed to this same 
format. PhotoCD images are supplied in various set resolutions on 
the disk and you should open the one most appropriate to your final 
output size and quality. If the image is still too large you can use 
Photoshop's Image Size command to resize it. For on-screen use, as 
for our project, it is possible to set the exact screen resolution. 
Photoshop is as intelligent as it can be during the resizing process, 
but inevitably some quality is lost and the process should only be 
used once. 

Another increasingly common format for the supply of stock 
photographs is the highly compressed JPEG (*.JPG). This is where 
the majority of the images used in our project come from, thanks to 
the selection that comes with PhotoImpact - sadly Photoshop itself 
seems to be above such bundling. The problem with JPEGs is that 
they are a "lossy" format which means that each time they are saved 
some information is discarded to keep the file size down. Once 
opened therefore they, and all our other images, should be saved to 
a new format. We'll come to final image formats later but for now, as 
we intend to work further on them, we can save to Photoshop's own 
format *.PSD. 

Now that we have acquired our images, the next step is to ensure 
that they are of the highest possible quality. Before we can do that, 
however, it is essential to ensure that the monitor has been calibrated 
correctly. This used to be a hideously complicated procedure 
involving external programs, but now the process is a simple, 
interactive walk-through procedure involving setting your white point 
and adjusting the gamma, colour balance, and black point. The 
necessary Monitor Setup command is available from the Colour 
Settings option under the File menu. 
 
 



 
Global Colour Correction 

Once we know that the on-screen colour is as true a reflection of the 
image on file as we can make it, we are ready to optimise it. 
Photoshop offers a whole raft of controls for globally manipulating the 
image's pixel data, all available from the Adjust option on the Image 
menu. The Brightness/Contrast command is probably the most 
obvious and most commonly used, but is a comparatively blunt 
instrument and is best avoided. Instead the first step should be to get 
an idea of the overall tonal map through the Levels command. This 
shows all the pixel data in the image as a histogram with the x-axis 
representing the colour values from the darkest to the lightest, and 
the y-axis representing the total number of pixels with that value. 

 

The levels command calls up an editable image map showing 
the distribution of all pixel values in the current image. 

For an image like the Rembrandt painting, or an underexposed 
photograph, all the values are concentrated to the left of the graph, 
while for an overexposed photo the reverse is true. Generally 
speaking, to have the values spread widely will give the greatest 
range and tonal depth. The beauty is that the histogram can be 
edited. It is possible to set the highlight, shadow and the midtone 
"gamma" and Photoshop will redistribute the current pixel values 
accordingly. In this way it is possible to correct exposure problems 
and even to bring out details that were not clear in the original. 

The best results are usually obtained by stretching the current values 



more equally across a wider tonal range and Photoshop offers the 
AutoLevels and Equalize commands to do this automatically. Both 
can be surprisingly effective, but for high quality work finer control is 
needed. This is offered by the Curves command which, although it 
does not show any information on the image's current values, allows 
the tonal range to be modified not just for the shadows, highlights 
and the mid tones, but for any point along the grayscale level. 

When the tonal balance is set, it is time to adjust any colour 
imbalances. Often an image will seem to have a colour cast, to be 
too red or too yellow, for example. Our main image of the gallery, for 
example, is far too green and so very cold and uninviting. Using the 
Adjust Colour Balance command it is possible to change the RGB 
levels of all the pixels in the image. Lowering the amount of red, 
green or blue in the image is the equivalent of increasing the amount 
of cyan, magenta and yellow respectively. Finally, with the adjust 
Hue/Saturation command, it is possible to completely shift the overall
- or even a particular - colour or to strengthen or desaturate colours 
that would otherwise be too muddy or too strong. 

 

Our main gallery image has a cold and unwelcoming green 
colour cast. Using the Colour Balance command it is possible to 
make the image much warmer.  

The final global correction that often needs to be made, particularly 
after scanning, is to tighten the focus of the image with a sharpening 
filter. All filters again do their work mathematically, altering the values 
of pixels depending on their current values and those of surrounding 
pixels. The various sharpen filters work by exaggerating the colour 



changes between adjacent pixels. As this can lead to an unwanted 
granular effect, it is better to use the Sharpen Edges or more often 
the Unsharp Masking filters, which only apply the effect where there 
is already a significant colour change. 

If you scan from halftoned printed material, rather than from a 
continuous tone photograph, you will often find an unpleasant moiré 
pattern in your image. You should probably treat this as a reminder 
that you do not have any rights to the image and find another, 
copyright-free source, but if you do continue you should reverse the 
sharpening process. Applying a Gaussian Blur will make the image 
less clear, but should help remove the patterned effect. If the effect is 
small the Despeckle filter might do the trick. 

There's no time here to go into all the other filters available as 
Photoshop comes with over 90 and more can be bought in as add-
ons (see boxout). The one point that remains true whatever the effect 
is that you should only ever use them for a reason as many of the 
filters, such as the numerous distortions, are driven more by maths 
than aesthetics. Some of the artistic effects on the other hand can be 
excellent ways of bringing to life an otherwise dull photograph of your 
head office or even partner. 

 

Photoshop has over 90 different filters, many of which allow the 
automatic creation of artistic effects. 
 
 
Local Editing / Retouching 



So far we have looked at ways of enhancing the overall image 
through global changes to the entire bitmap. To change individual 
pixels, Photoshop's tools are brought into play. Most users are 
familiar with the brush tool for applying coloured strokes if only 
through memories of Windows Paintbrush. Although the principle 
remains the same, as you would expect with Photoshop, there are a 
number of enhancements. These are set with the Brushes and 
Brushes Options palette, accessed most simply by double clicking on 
the tool.  

As well as choosing between different brush sizes and hardnesses, it 
is possible to set the opacity - or transparency - of the stroke. This is 
very significant as it means that the underlying image is not 
necessarily obliterated by the new colour. The other most important 
setting is the painting "mode". There are 14 possible options ranging 
from Normal through to Luminosity. Again each mode is based on a 
combination of an algorithm and the existing pixel values. For 
example with the Darken mode selected, the brush will only apply the 
new colour if it is darker than the current colour. 

In fact painting with the brush plays a surprisingly small role when 
photo-editing. More common is the use of the various retouching 
tools, each of which works with the pixel information already there in 
the image. The Sharpen and Blur tools apply the same effects as the 
global filters while the Smudge tool acts like a finger smearing wet 
paint. The Dodge and Burn tools respectively lighten and darken the 
underlying pixels, while the Sponge tool is used to change their 
colour saturation. 

One huge advantage computer-based editing offers over traditional 
photo retouching is the ability to clone, effectively painting with a 
copy of the existing image. This is done through setting a source by 
Alt + clicking and then painting with the Rubber Stamp tool. Exact 
replicas can be created to produce Anchor-butter-cow style effects, 
or more usually small imperfections can be quickly removed. For our 
project, the existing paintings on the gallery wall aren't eye-catching 
enough so I've cloned them out, painting over them with the 
surrounding wall. 



 

One of the most useful retouching tools is the cloning tool 
which can be used to duplicate or remove existing elements. 

Handling Selections 

With global correction or local retouching we can work with the 
bitmap image as a whole or with individual pixels. In fact though, 
most images are made up of distinct and discrete objects so that a 
portrait, for example, will include a head, while a landscape is likely to 
include a sky or trees. Often it makes far more sense to work with 
these logical units, to sharpen the features of the face or to change 
the sky from sunny to lowering for example. To be able to work with 
these components of the image as units, they must first be selected. 
With a selection made, any editing only affects the selection. 

The problem is that, to Photoshop, the image is nothing more than a 
grid of values. The program cannot see the objects that the eye can, 
so it is up to the user to create the selection. Photoshop offers a 
number of tools to help, but the process still represents the biggest 
hurdle for the occasional user to jump. For rectangular or oval 
objects, the marquee select tools are straightforward. For irregular 
but clearly defined objects, the lasso tool is used to create an outline. 
At all times it is possible to add to the selection by holding down the 
Shift key, or subtract from it by holding down the Alt key. To invert the 
selection or to remove it entirely, the commands from the Select 
menu must be used. 

If the object is clearly marked by its colour it is possible to have 
Photoshop automatically make a selection, in our example, to isolate 



the white statue from its blue background. Using the magic wand tool 
and clicking on a pixel automatically selects all the adjacent pixels 
that are of sufficiently similar colour. This colour "tolerance" is 
specified with the Brush Options palette. Selecting the Grow 
command will extend the selection to those pixels adjacent to the 
current selection that fall within the specified tolerance. Selecting the 
Similar command will select all such colours throughout the image. 
The Colour Range command allows a similar process to be applied 
interactively and precisely within an on-screen dialog. 

 

Using the magic wand or the colour range command it is 
possible to make a selection based on colour similarity. 
Selections can then be stored as channels. 

Using the colour selection tools will often select the majority of your 
intended object, but still leave holes or rough edges. This is where 
Photoshop's Quick Mask feature comes in. In Quick Mask mode, all 
unselected - and therefore protected - areas of the image are shown 
covered with a transparent ruby red mask. Using the brush tool set to 
either black or white it is possible to add to, or subtract from, this 
mask simply by painting. When you return to normal editing mode the 
unmasked areas become the new selection.  

The other advantage of Quick Mask mode is that it is possible to 
create a grayscale rather than a solid selection. Any future editing will 
then depend on the opacity of the mask at that given point. For 
example with the gradient tool it would be possible to draw on a 
radial gradient mask centred on the face of a portrait and getting 
weaker towards the edges of a picture. You could then apply a blur 



filter that would leave the face unaffected but produce an old-
fashioned vignette effect towards the edge of the image.  

Having gone to such effort to mark off a selection of an image, it's 
just as well that Photoshop allows them to be saved. With the Save 
Selection command the outline of the mask and any grayscale 
information is stored as an "alpha channel". Multiple selections can 
be saved and then brought back into play with the Load Selection 
command. To see the selections stored in an image you can call up 
the Channels palette, which also shows the individual Red, Green 
and Blue components of a colour image. 

As well as being useful as masks to control editing and retouching, 
selections can be manipulated and transformed in a number of other 
ways. To begin with they can be cut, copied and pasted. If a selection 
is cut, it is automatically replaced by the current background colour 
which is the quickest way of filling a given area. If the selection is 
moved with the dedicated Move tool, it becomes a temporary floating 
selection, floating above the image below. To prevent obvious edges 
on copied selections it is possible to feather and anti-alias the 
selection's border which respectively blurs the transition and smooths 
out any potential jaggies.  

It is also possible to transform a selection by resizing, rotating, 
skewing or applying a perspective effect. In the past these 
transformations used to be done individually with the separate Select 
menu commands, but in Photoshop 4.0 each option can be accessed 
by choosing the Free Transform command and then choosing from 
the right mouse button's shortcut menu. For example, to add the new 
artwork to the gallery, I was able to use the Free Transform 
command's Perspective option to align the pictures correctly with the 
walls (see walkthrough). Photoshop 4.0 does not implement any 
changes until all have been applied and the user has double-clicked 
within the selection, or pressed the Enter key.  
 
 
 
Layers 

By bringing external selections into our image we are moving into the 



realms of photomontage and it is important to bring in a new concept; 
the layer. By directly pasting the new paintings onto the wall, the 
underlying pixel data would be changed irreversibly so that it would 
be impossible to simply reposition them. Instead Photoshop allows 
the selection to be kept on a separate layer above the image 
background. Each layer is like a transparent sheet of acetate stacked 
one on top of the other. Where there is nothing on the layer you can 
see any underlying layers and the underlying background image. 

 

The advantages of layers are obvious. Each can be edited separately 
so that it is possible to scale, reposition, recolour and so on without 
affecting the rest of the image. The down sides are that each layer 
adds to the file size, slows down processing and brings in a whole 
new level of complexity. Even so for the professional user these are 
prices well worth paying as by copying a selection to its own layer, 
the flexibility and creative options on offer are instantly and 
dramatically increased. 

Layers have become so integral to the photo-editing process that if 
you paste a selection into a background image in Photoshop 4.0 it is 
now automatically assigned to its own layer. The easiest way to 
create a layer is therefore to create a selection and copy and paste it. 
The new layer will automatically appear with a small thumbnail of its 
contents on the all-important Layers palette. The currently active 
layer is highlighted and it is crucial to understand that only this layer 
can be edited. If in future you find yourself unable to edit a section of 
your image, nine times out of ten it will be because this section is 
actually part of another, currently unselected, layer. 



Once created, the control over layers are comprehensive. The 
stacking order of layers can be reordered simply by dragging up and 
down within the Layers palette. It is also possible to hide and reveal 
layers by clicking on the eye symbol in the leftmost column and to 
group layers by clicking in the second column. At the top of the 
palette are two important options that affect how the current layer 
interacts with the underlying image. Changing opacity affects the 
layer's transparency, while the mode options are identical to those 
available for the tools. 

 

Typical examples of the use of layers would be for text and for 
shadow effects. Photoshop's control over text is very rudimentary 
and is only designed for adding the occasional word or phrase. 
Because text is now automatically added to its own layer, however, 
simply by changing the opacity or setting the mode to overlay, for 
example, some very striking effects can be achieved. Shadows can 
be created by duplicating a layer, distorting the selection, filling it with 
a gradient fill and then blending the shadow into the background 
image by setting the mode to multiply. By grouping the two layers, if 
the object is moved, its shadow will move with it. 



 

By copying a selection to a layer, distorting it and applying a 
gradient fill, it is possible to create a realistic shadow. 

Further control is offered by the use of layer masks. If the Add Layer 
Mask command is selected from the Layer menu an extra thumbnail 
appears to the right of the current layer in the palette. Alt + clicking 
on the thumbnail calls up the mask where it is possible to control 
which sections of the current layer are visible. This is where the use 
of graduated masks really comes into its own, creating subtle fade 
effects. 
 
 
Adjustment Layers 

Completely new in Photoshop 4.0 is the use of adjustment layers, 
added with the command under the Layers menu. These act like 
lenses applying any of the nine image adjustments such as curves, 
levels or hue/saturation to all underlying layers. The beauty is that 
each effect remains editable. If the effect is too strong, for example, 
the opacity can be lowered. Even better, by simply double clicking on 
the layer name, the relevant adjustment dialog can be called up 
again and new parameters defined.  

As with layer masks, it is possible to paint on the adjustment layer to 
limit the effect to certain sections of the underlying image. In our 
gallery image, for example, I was able to add a hue/saturation 
adjustment mask. By selecting the walls, cutting and pasting them to 
the adjustment layer and then deleting them so that they are filled as 



solid, the hue/saturation effect is limited to just this area of the image. 
It's a complicated procedure, but it means that at any time in future 
the colour of the walls can be changed by simply double-clicking on 
the adjustment layer and altering the hue. 

 

By adding an adjustment layer with its own mask so that only 
the walls are affected, it is possible to recolour the wall to suit 
the pictures. 

Photoshop's controls over the creation of photomontages are 
unrivalled and the only way to truly get to grips with them is to 
practice on your own projects. The main steps in the creation of the 
gallery image are outlined in the Putting It All Together box out and 
show the sort of effects that can be achieved. When you are finally 
happy with the image you have created the job is nearly over, but not 
quite. First the image must be output into a format that can be used 
by other programs. Our project, like a graphic intended for a home 
page, was only ever going to be seen on-screen, so the final step is 
to save it to a format such as a GIF or a JPG suitable for the Web 
(see Web box out). 

RGB and CMYK 

If you are intending to output your image from a DTP program, you 
will be better off saving to the industry-standard TIFF (Tagged Image 
File Format). If the final output of your image will be to your own 
desktop printer the default RGB TIFF will be fine. However, if your 
image is going to end up commercially printed and so output as 
colour separations, there is another stage to go through. Almost all 



colour print is based on the CMYK (cyan, magenta, yellow and black) 
system, so you first have to convert your 24-bit RGB TIFF to a 32-bit 
CMYK format with the Image Mode command. 

This conversion is not a simple one-to-one translation as the RGB 
and CMYK colour spaces are very different. In particular some 
colours are viewable on screen but cannot be printed. Photoshop can 
indicate these out of range colours throughout an image with the 
Gamut Warning option under the View menu, which then allows the 
hue/saturation to be massaged back into the CMYK gamut. 
Unfortunately that's not the end of the problems for the professional 
designer as the final output colour also depends on advanced factors 
such as dot gain and gray balance. Photoshop allows all of these 
parameters to be controlled precisely on the desktop, but as they 
depend on external factors such as paper stock, it is best to discuss 
the options with your printer and often preferable to leave the entire 
colour separation process to them.  

Having done so much ourselves, it's a slight disappointment to have 
to say that any photo-editing process is still best left to the 
professionals. Even so we've managed to achieve a great deal from 
basic colour correction through to advanced photo-composition. 
Hopefully, next time you scan a photo you won't necessarily just save 
it and leave the program. 
Tom Arah 

Working for the Web  
One of the most important areas for the current graphic designer is 
the production of images for the Internet. Our final image, for 
example, could be destined to be part of a gallery home page where 
people could see and give feedback on the exhibition proposals. The 
actual process for producing the image is the same whether it is 
intended for on-screen or on-paper use. The only working difference 
is that, for the typical 72dpi of on-screen use, the images can 
generally be kept much smaller. 

The real contrast comes when saving the file. The absolute 
prerequisite for Web images is that they should be kept as small as 



possible to cut down on download time. For high quality, full colour 
work the best format is the JPEG (Joint Photographic Experts 
Group). Different levels of compression are available all of which 
discard some data considered non-essential. A new lossless, true 
colour format the PNG (Portable Network Graphics) is becoming 
increasingly popular on intranets and the wider Internet as browser 
support for it increases.  

For the majority of images used on-screen, the full range of 16.7 
million colours is a luxury that cannot be afforded. Instead the colour 
depth must be cut down by converting the image mode from RGB to 
Indexed colour. This offers the options to set the pixel depth from 3 to 
8 bit and therefore the number of ultimate colours from 8 to 256. The 
latest Photoshop 4.0 also allows the palette to be kept to the 216 
core colours viewable by all Web browsers without dithering. Once 
the colour depth has been changed the image can be saved to the 
standard GIF (Graphics Interchange Format).  

 

Photoshop's handling and support for Web graphics is weak 
compared to that in the latest version of PhotoImpact.  

Photoshop's Web support is functional, but hardly impressive. For a 
dedicated and integrated approach, the latest version 3.01 of 
PhotoImpact, provides a number of Web Extensions. These offer 
various controls such as frame, background and button designers, 
but it is the GIF and JPEG "Smartsaver" dialogs that really make the 
difference. To be able to change colour depth and compression 
settings and instantly see the effects on both image quality and file 
size is a breakthrough. Having used the Smartsavers, Photoshop's 



trial-and-error approach seems like working half-blind. 

Tom Arah 

August 1998 
 
  

  
... and in need of support! 

  
All the work on the site (over 200 reviews, 85 articles and a dozen 
tutorials) has been written by me, Tom Arah It's also me who 
maintains the site, answers your emails etc. The site is very popular 
(over 175,000 visitors and more than 6 million hits a month!) and 

from your feedback I know it's a useful resource - but it takes a lot to keep it 
up.  
You can help keep the site running, independent and free in four main 
ways:  
 
Bookmark the site (if you don't you might never find it again), tell others 
about it (direct links are available at the bottom of each page) and keep 
coming back (new content is added every month)  
Make a small donation eg $5 (or a big one :) via Paypal:  

 
Support the site advertisers. Please keep your eye on the googleads at the 
top of each page and click-through to any that look interesting. And click on 
the site's software banner ads to get your hands on a free trial or special 
offer. 
Buy via Amazon.com (now or next time you feel like shopping) using this 
link or the mall below - it's a great way of quickly finding the best buys, it 
costs you nothing and I gain a small but much-appreciated commission. 
Alternatively, if you'd prefer to buy via Amazon.co.uk or Amazon.ca or 
eBay.co.uk then please do so via these links. 
Thanks very much 
Tom Arah 

 

 


